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HOW TO SETUP SERVER BACKUPS ON
WINDOWS SERVER 2022

Author(s): Louis Ouellet

Backups are an essential part of any server management strategy. They provide a way to
recover data and system configurations in case of data loss or system failure. In this guide, we
will be setting up server backups on Windows Server 2022. This will allow you to create regular
backups of your server's data and system state, which can be used to restore the server in case
of data loss or system failure.

In this guide, we will be setting up server backups on Windows Server 2022. This will allow you
to create regular backups of your server's data and system state, which can be used to restore
the server in case of data loss or system failure.
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PREREQUISITES

e A server running Windows Server 2022
e A user account with administrative privileges
» A network share to store the backups

STEP 1: INSTALL WINDOWS SERVER BACKUP FEATURE

1. Open Server Manager by clicking on the and selecting Server Manager.

T Server Manager

Server Manager * Dashboard c @1 mansse Toor  vew e

WELCOME TO SERVER MANAGER

I Dashboard

B Local Server

i Al Servers . !

i; o o S o Configure this local server
ile and Storage Services

Ie s QUICK START

. NPAS 2 Add roles and features
Remote Desktop S b
© Remote Deskiop Sevices 3 Add other servers to manage
WHAT'S NEW o
4 Create a server group
5 Connect this server to cloud services
Hide
LEARN MORE
ROLES AND SERVER GROUPS

Roles:4 | Servergroups:1 | Serverstotal: 1

Remote Desktop

=m File and Storage =
= Services ’ ! o 1S ! A neas ! Services !
@ Manageability @ Manageability @ Manageability @ Manageability
Events Events Events Events
Performance Services Services Services
BPA results Performance Performance Performance
BPA results BPA results BPA results

R Type here to search

2. In the Server Manager window, click on Manage in the top-right corner and select Add
Roles and Features.
3. Select Role-based or feature-based installation and click Next
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Manage  To

[ERIEEIRY . Add Roles and Features Wizard

B Local Serve|

Allservers [ Selact installation
File and Stq

s Before You Begin

NPAS

Remote De{

DESTINATION SERVER
type

APD-01 albcie.com

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).
® Role-based or feature-based installation

Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation

Install required role services for Virtual Desktop Infrastructure (VD) to create a virtual machine-based
or session-based desktop deployment.

Hide

Remote Desktop
Services

Server Manager *

I BPA results I BPA results

- Windowec

Dashboard

[PEENLREIGNY - Add Roles and Features Wizard
0 Local Serve
E& Alseners | Select destination
W} File and Stq
o s Before You Begin
. neas
@ Remote De{

DESTINATION SERVER
APR-01 3lbcie.com

server

Select a server or a virtual hard disk on which to install roles and features.

Select a server from the server pool
©) Select a virtual hard disk

Server Pool

Filter:

Name 1P Address Operating System

Microsoft Windows Server 2022 Datacenter

1 Computer(s) found

This page shows servers that are running Windows Server 2012 or a newer release of Windows Server,
and that have been added by using the Add Servers command in Server Manager. Offline servers and
newly-added servers from which data collection is still incomplete are not shown.

® Manageability
Events
Services
Performance

BPA results

~ T dy) ENG

| I' Manage Tools  View

Hide

Remote Desktop
Services

R Type here to search

| ‘ BPA results | ‘ BPA results

5. In the Server Roles window, click Next .
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APP-01 -

Server Manager * Dashboard ( Menage Tooks  View Help

[ FEEEILEIN] [ Add Roles and Features Wizard - [m] x

Local Serve|

DESTINATION SERVER

Allsenvers | Select server roles 49201 sciecom
W File and Stq

o s Before You Begin Select one or more roles to install on the selected server.
. neas Installation T

@ Remote De{

Roles Description

File and Storage Services includes
services that are always installed, as
well as functionality that you can
install to help manage file servers
and storage.

[] Active Directory Certificate Services
[ Active Directory Domain Services
[] Active Directory Federation Services
[ Active Directory Lightweight Directory Services
[ Active Directory Rights Management Services
[ Device Health Attestation
] DHCP Server 3
[ DNS Server Hide
[ Fax Server

File and Storage Services (1 of 12 installed
[ Host Guardian Service
[ Hyper-v
[ Network Controller
' Network Policy and Access Services {Installed)
[] Print and Document Services

Remote Desktop

[ Remote Access 1 N 1
o [W] Remote Desktop Services (5 of 6 installed) Services
[ Volume Activation Services N
b (W] Web Server (1IS) (21 of 43 installed) @ Manageability
[ Windows Deployment Services Evenes
Services
| ‘ BPA results | ‘ BPA results BPA results

pel Type here to search t A B 43 ENG

Server Manager * Dashboard ) Manage  Tools
[T ERIEEIRY . Add Roles and Features Wizard - ] %
Local Serve I
DESTINATION SERVER
Allservers | - Selact features APD-01 slocie.com
File and Stq
s Before You Begin Select one or more features to install on the selected server.
NPAS Installation Features Description
® Remote Def i System Data Archiver (Installed) Windows Server Backup allows you
[ System Insights to back up and recover your
[ Telret Client operating system, applications and
] TFIP Client data. You can schedule backups, and
[ VM Shielding Tools for Fabric Management protect the entire server or specific
[] WebDAV Redirector volumes.
[ Windows Biometric Framework )
[ Windows Identity Foundation 3.5 Hide

¥ Windows Internal Database (Installed)
W] Windows PowerShell (2 of 4 installed)

[ Windows Process Activation Service

[ Windows Search Service

[ Windows Server Migration Tools

[ Windows Standards-Based Storage Management

Remote Desktop

] Windows Subsystem for Linux 1 ¢ 1
] Windows TIFF IFilter Services
E m:z\g!::tmmn ® Manageability
Events
Services
== Performance
| ‘ BPA results | ‘ BPA results BPA results

pe Type here to search i ~ T di) ENG

https://laswitchtech.com/ Printed on 2026/05/19 19:22



2026/05/19 19:22 7/16 How to Setup Server Backups on Windows Server 2022

7. Click Install to begin the installation process.

APP-01 - Windowed

Server Manager * Dashboard 2) Monage  Tooks  View  Help
E [PEECEEINE e Add Roles and Features Wizard - ] X
§ Local Serve| I
) H . DESTINATION SERVER
Ei Anseners | Confirm installation selections AP5-01 atocie.com
W} File and Stq
e s To install the following roles, role services, or features on selected server, click Install.
T nPas [7] Restart the destination server sutomatically if required
Optional features (such as administration tools) might be displayed on this page because they have
Remote De{ (3 g play Pag Y

been selected automatically. If you do not want to install these optional features, click Previous to clear
their check boxes.

Windows Server Backup

Hide

Remote Desktop
Services

. Cf) Manageability
Export configuration settings

Specify an alternate source path Events

Services

Performance

T BPA results I BPA results BPA results

R Type here to search

APP-01 - Windc
rver Manager * Dashboard ) | |'1 Manage  Tools  View  Help
TEOEEICEETR] o Add Roles and Features Wizard - O X
Local Serve

DESTINATION SERVER

Allservers | |nstallation progress 499.1 alociom
ii File and Stq|

s View installation progress
4 Neas @ Festure installation
@ Remote De{

Installation succeeded on APP-01.albcie.com,

Windows Server Backup

Hide

Remote Desktop

1 : 1
Services
You can close this wizard without interrupting running tasks, View task progress or open this
Bl page again by clicking Notifications in the command bar, and then Task Details. (® Manageability
Export configuration settings Events
Services
< Previo Ne Cance
Shau = Performance
| ‘ BPA results | ‘ BPA results BPA results

R Type here to search i ~ T Q) ENG
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STEP 2: CONFIGURE WINDOWS SERVER BACKUP

1. Open Server Manager by clicking on the and selecting Server Manager.
2. In the Server Manager window, click on Tools in the top-right corner and select Windows
Server Backup.

[ ]
Server Manager
Server Manager * Dashboard - (@) | P verose Tools view ety
Component Services
Computer Management
[a—— WELCOME TO SERVER MANAGER
ashboan Defragment and Optimize Drives
B Local Server Disk Cleanup
& All Servers Confi i< | | Event Viewer
) e B ontigure this local server e et ety et (W) RSy pet
o Iis s iSCS Initiator
[ ] B 7dd roles and features Local Security Policy
. Npas b S e Microsoft Azure Services
@ Remote Desktop Services b 3 Add other servers to manage LTSI
ODBC Data Sources (32-bif)
WHATE NEW 4 Create a server group ODBC Data Sources (64-bit)
Performance Monitor
5 Connect this server to cloud services Recovery Drive
Registry Editor
LEARN MORE Remote Desktop Services >
Resource Monitor
o
ROLES AND SERVER GROUPS srees
Roles:4 | Servergroups:1 | Servers totak: 1 SEEETTIET
System
== File and Storage =
in ) 1 1S 1 ?1‘ NPAS 1 Task Scheduler
Services Windows Defender Firewall with Advanced Security
@ Manageability @ Manageability @ Manageability Windows Memory Diagnostic
Events Events Events Windows PawerShel
i . Windows PowerShell (x86)
Performance Services Services Windows Server Backup
BPA results Performance Performance Performance T
BPA results BPA results BPA results

pel Type here to search

3. In the Windows Server Backup window, click on Local Backup in the left pane.
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whadmin - [Windows Server Backup (Local)\Local Backup)
badmin - [Windows Server Backup (Local)\Local Backup]

=] X
File Action View Help
&= 2@ D
18 Local Backup Local Backup
Local -

'by You can perform a single backup or schedule a regular backup using this application. Backup Schedule...

Backup Once...
A\ No backup has been configured for this computer. Use the Backup Schedule Wizard or the Backup Once Wizard to perform a regular or one-time backup.

L

Recover...
Messages (Activity from last week, double click on the message to see details)

Configure Performance Settings...

Time Message Description View 4
Help

Status

Last Backup Next Backup All Backups

Status: - Status: Total backups: 0 copies

Time: - Time: Latest copy: -

B View details B View details Oldest copy: -

B View details
v

< PAIRS

pel Type here to search

71 d3) ENG

4. Click on Backup Schedule in the right pane.
5. In the Backup Schedule Wizard, click Next .

& Backu =
File Action View Help
| 0@ HE

W Windows Server Backup (I e Bed ¥ Backup Schedule Wizard X - Actions
b Local Backup 3 & -

) sa ) Locol Gechup

b Youan perform) ¥ % Getting Started do Backup Schedule..

- 3@ Backup Once..
A\ No backup has been c: p. 19 Recover
. Getting Started e wi : S

= (etivity from tast v  Vou can use this wizard to configure backups to run on 2 regular schedule. Configure Perormance Settinge

Select Backup Confi it...
- cleck Backup Lonhgura To creste  backup schedule, you should first decide: — N
Time Specify Backup Time - What to back up (Full Server, System State, selected files, folders or volumes)
- When and how often to back up your server H Hep

Specify Destination Type - Where to store the backups
Confi i
onfirmation Toeri o o
Summary

Status

Last Backup

Status: -

Time: -

B View details

Finish Cancel
v
< > ||« >

pel Type here to search

\ £ q)) ENG
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6. In the Backup Schedule Wizard, select Custom and click Next .

File Action View Help
&= 2@ HE
Wb Windows Server Backup (1 ol Bedips Y Backup Schedule Wizard X ' Actions
b Local Backup
Local Backup -
3 Yga .
b You can perform :‘_:i&l_.:l Select Backup Configuration ¥ Backup Schedule..
- 3@ Backup Once..
A\ No backup has been c P. 19 Recover
. Getting Started What type of configuration do you want to schedule? S
Messages (Activity from last w P s - Configure Performance Settings...
O Full server (recommended)
Time Selec Items for Backup | want to back up all my server data, applications and system state, View 4
i 7
ST Backup size: 3.62 TB Help
Specify Destination Type ® Custom
| want to choose custom volumes, files for backup.
Confirmation
Summary
Status
Last Backup
Status:
Time:
B View details
= =
v
< >||< >

7. In the Backup Schedule Wizard, select the items you want to back up by pressing
Add .
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@ : o
File Action View Help
&= 2@ D
Windows Server Backup (| o Backy ule Wizard X ~ [Actions
»ﬂ, Local Backup cal Backup Local Backup "
¥ | dga
y You can perform | Eﬁ.l Select Items for Backup ¥ Backup Schedule..
— ¥ Backup Once...
A\ No backup has been c¢ » Select lterms X P 1® Recover..
. ing
Messages (Activity from last w o ) ) o Configure Performance Settings...
Select B{  Specy items to include in the backup by selecting or clearing the associated check baxes. The temsthat you |
< have included in the cument backup are already selected | View »
Tme
Specify Help
specy| | I Bare et rcovey
Cenfirm| {[TJea» EFI System Partition
sumng [ Local disk (C)
> (Disk does not have dive letter) (WP\Volume {330678¢7-2¢14-40c(0-Scbb-25c4ec Ted 2401
k@ Application (G:)
[Tk Backups (D)
Status
Last Backup
>
Status: -
e - o |
B View details
< Previous Next Cancel
v
< PAIRS >

pel Type here to search

8. In the Backup Schedule Wizard, click Next .

= K 2]
File Action View Help
&= 2o HiE
W Windows Server Backup ( _ ¥ Backup Schedule Wizard % ' Actions
1 Locel Backup Local Backup =
¥ Jga
b You can perform g::fi. Select Items for Backup ¥ Backup Schedule.
e 3@ Backup Once...
i
A\ Mo backup has been ¢ N P. 1o Recover.
- etting Starte : :
Messages (Activity from last Se\eatr‘e:emsthatyuu Eto ba:: up. S:f\ectmg bare metal recovery will provide Configure Performance Settings...
Select Backup Configurat.—. you with the most aptions if you need to perform a recovery.
= ~ View »
Time Select Items for Backup Name
Hel
Specify Backup Time & Application (G:) elp
Specify Destination Type
Confirmation
Summary
Status
Last Backup
< >
Status: -
B} View details Advanced Setfings
< Previous Next > Cancel
v
< > || < >

e here to search

9. In the Backup Schedule Wizard, select the time and day you want to run the backup and
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click Next .

@

File Action View Help

&= | 2@ EHiE

»xn:;m:;:xi’l%ackup i ol Bedips Y Backup Schedule Wizard X ' Actions

¥ ) Locl B 3
4 " "
b You can perform 31_-:' Specify Backup Time ¥ Backup Schedule...
R
3@ Backup Once..
A\ No backup has b
o backup has been ¢ I P. 1o Recover.
. ing Starte How often and when do you want to run backups?
Messages (Activity from last w B = Configure Performance Settings...
Select Backup Configurat.. @ Onceaday
Time Select Items for Backup. Select time of day: | g:00 pM Y View '
= [d He
Specify Backup Time O More than once a day B nep
R D Click an available time and then click Add to add it to the backup schedule.
Available time: Scheduled time:
Confirmation
~ 300 PM
Summary
Add >
Status < Remove
Last Backup v
Status:
Time:
B View details
o R [ o
v
< > ||«

pel Type here to search

10. In the Backup Schedule Wizard, select the destination Back up to a shared network
folder for the backup and click Next .
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@

File Action View Help

&= 2@ D

Wb Windows Server Backup (] el B 5 Backup Schedule Wizard X
W Local Backup

A=
Q\y rfi \-\;a & =
). You can perform Qif Specify Destination Type ¥ Backup Schedule...
= ¥ Backup Once...
A\ No backup has been P. 1o &
Recover..
Getting Started 2
Messages (Activity from last ? Where do you went to stere the bockups? Configure Performance Settings...
Select Backup Configurat.. () Back up to a hard disk that is dedicated for backups (recommended)
View 3
Time Seect tems for Backup Choose this option for the safest way to store backups. The hard disk that you use

will be formatted and then dedicated to anly store backups. el
Specify Backup Time v

1 O Back up to a volume

Speci pe

Choose this option if you cannot dedicate an entire disk for backups. Note that the
Specify Remote Shared F... performance of the volume may be reduced by up to 200 percent while it is used
Confirmation 1o store backups. We recommend that you do not store other server data on the
same volume.
Summary
@® Back up to a shared network folder

Chaose this aption if you do not want ta store backups locally on the server, Note
that you will only have one backup at a time because when you create a new
Status backup it overwrites the previous backup.

Last Backup
Status: -
Time: -
B View details
T ; Concel
v
< PAIRS

pel Type here to search

1 ) ENG

11. In the Backup Schedule Wizard, enter the network path to the shared folder and click
Next .

File Action View Help
L 2] o} ? o
Wb Windows Server Backup (1 o] B Y Backup Schedule Wizard X ' Actions
1 Local Backup -
3 rform| S
You can perform| % .
= P C_j-'_r Specify Remote Shared Folder Yo Backup Schedule...
- 3@ Backup Once..
A\ No backup has been c p. 19 &
Recover.
. Getting Started Location:
Messages (Activity from last w Configure Performance Settings...
Select Backup Configurat.. \\ALBCIE\Shares\Backups\APP-01|
View »
Time Select Items for Backup Example: \\MyFileServer\SharedFolderName
Hel
Specify Backup Time This wizard creates a folder based on the name of the server being backed up, for P
example MyServer-BackupFiles.
Specify Destination Type
Specify Remote Shared F... Access Control
Confirmation
Summary
@ Inherit
= This option makes the backup accessible to everybody who has access to the
e specified remote shared folder.
Last Backup .
(i) The backed up data cannot be securely protected for this destination.
Status: , More Informatien
Time: -
B View details
S : s
v
< >||< >

R Type here to search

\ 1 d9) ENG
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12. In the Backup Schedule Wizard, enter the credentials to access the shared folder and
click Next .

13. In the Backup Schedule Wizard, review the backup settings and click Finish

File Action View Help
&= 2o HiE
W Windows Server Backup ( _ ¥ Backup Schedule Wizard % ' Actions
D
¥ Locel Backup Local Backu =
¥ YA S
b You can perform| X #%  Confirmation Y Backup Schedule...
- 3@ Backup Once...
A\ Nobackup has been c p. 8 Recover
. Getting Started You are about to create the following backup schedule. S
Messages (Activity from last . Configure Performance Settin
Select Backup Configurat..  Backup times: 800PM
Time Select tems for Backup Files excluded: None Yiew
Specity Backup Time Advanced option: VS5 Copy Backup H Hep
Specify Destination Type Backup destinations:  \\ALBCIE\Shares\Backups\APP-01
Specify Remote Shared F... Backup items .
Summary i Apphcation (G
Status
Last Backup
Status:
Time: .
B View details
P e
v
< > || < >
AP Type here to search

TROUBLESHOOTING

1. If you encounter any issues during the setup process, you can refer to the
Windows Server Backup documentation for troubleshooting steps.

2. You can also check the Windows Event Viewer for any error messages related
to the backup process.

TIPS

1. Make sure to test the backup process regularly to ensure that your backups are

https://laswitchtech.com/ Printed on 2026/05/19 19:22



2026/05/19 19:22 15/16 How to Setup Server Backups on Windows Server 2022

working correctly.
2. Store your backups in a secure location to prevent data loss in case of a

Q disaster.
3. Consider setting up a backup rotation schedule to keep multiple copies of your

backups.

CONCLUSION

In this guide, we have set up server backups on Windows Server 2022. This will allow you to
create regular backups of your server's data and system state, which can be used to restore the
server in case of data loss or system failure. By following the steps outlined in this guide, you
can ensure that your server is protected against data loss and system failure.
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